Chapter 11

Stuff for Students

To be blunt, many of us are lousy teachers, and our efforts to improve are
feeble. So students frequently view statistics as the worst course taken in

college.
Hogg (1991)

11.1 R/Splus Statistical Software

R /Splus are statistical software packages, and R is the free version of Splus.
A very useful R link is (www.r-project.org/#doc).

As of January 2012, the author’s personal computer has Version 2.13.1
(July 8, 2011) of R and Splus—2000 (see Mathsoft 1999ab).

Downloading the book’s R/Splus functions sipack.trt into R or
Splus:

In Chapter 9, several of the homework problems use R/Splus functions
contained in the book’s website (www.math.siu.edu/olive/sipack.txt) under
the file name sipack.tzt. Suppose that you download sipack.txt onto a flash
drive. Enter R and wait for the cursor to appear. Then go to the File menu
and drag down Source R Code. A window should appear. Navigate the Look
in box until it says Removable Disk (G:). In the Files of type box choose All
files(*.*) and then select sipack.tzt. The following line should appear in the
main R window.

> source("G:/sipack.txt")
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Type Is(). About 9 R/Splus functions from sipack.trt should appear.

Alternatively, from the website (www.math.siu.edu/olive/sipack.txt), go
to the Edit menu and choose Select All, then go to the Edit menu and choose
Copy. Next enter R, go to the Edit menu and choose Paste. These commands
also enter the sipack functions into R.

When you finish your R/Splus session, enter the command ¢(). A window
asking “Save workspace image?’ will appear. Click on No if you do not want
to save the programs in R. (If you do want to save the programs then click
on Yes.)

If you use Splus, the command

> source("A:/sipack.txt")

will enter the functions into Splus. Creating a special workspace for the
functions may be useful.

This section gives tips on using R/Splus, but is no replacement for books
such as Becker, Chambers, and Wilks (1988), Chambers (1998), Crawley
(2005, 2007), Dalgaard (2002) or Venables and Ripley (2010). Also see
Mathsoft (1999ab) and use the website (www.google.com) to search for useful
websites. For example enter the search words R documentation.

The command ¢() gets you out of R or Splus.

The commands help(fn) and args(fn) give information about the function
fn, eg if fn = rnorm.

Making functions in R and Splus is easy.

For example, type the following commands.

mysquare <- function(x){
# this function squares x
r <- x72

r }

The second line in the function shows how to put comments into functions.
Modifying your function is easy.

Use the fix command.
fix(mysquare)
This will open an editor such as Notepad and allow you to make changes.
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In Splus, the command FEdit(mysquare) may also be used to modify the
function mysquare.

To save data or a function in R, when you exit, click on Yes when the
“Save worksheet image?’ window appears. When you reenter R, type Is().
This will show you what is saved. You should rarely need to save anything
for the material in the first thirteen chapters of this book. In Splus, data
and functions are automatically saved. To remove unwanted items from the
worksheet, eg z, type rm(z),
pairs(z) makes a scatterplot matrix of the columns of z,
hist(y) makes a histogram of y,
bozplot(y) makes a boxplot of ¥,
stem(y) makes a stem and leaf plot of y,
scan(), source(), and sink() are useful on a Uniz workstation.

To type a simple list, use y <— ¢(1,2,3.5).
The commands mean(y), median(y), var(y) are self explanatory.

The following commands are useful for a scatterplot created by the com-
mand plot(z,y).
lines(z,y), lines(lowess(x,y,f=.2))

identify(z,y)
abline(out$coef ), abline(0,1)

The usual arithmetic operators are 2+ 4, 3 — 7, 8 x4, 8/4, and
2°{10}.

The ith element of vector y is y[i] while the ij element of matrix = is
x[i, j]. The second row of z is x[2,]| while the 4th column of x is z[,4]. The
transpose of z is t(z).

The command apply(z,1,fn) will compute the row means if fn = mean.
The command apply(z,2,fn) will compute the column variances if fn = var.
The commands cbind and rbind combine column vectors or row vectors with
an existing matrix or vector of the appropriate dimension.
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11.2 Hints and Solutions to Selected Prob-
lems
1.10. d) See Problem 1.19 with Y =W and r = 1.

f) Use the fact that E(Y") = E[(Y?)/?] = E(W"/?) where W ~ EXP()).
Take r = 1.

1.11. d) Find E(Y") for r = 1,2 using Problem 1.19 with Y = W.
f) For r = 1,2, find E(Y") using the the fact that E(Y") = E[(Y?)"/?¢] =
E(W'/?) where W ~ EXP()).

1.12. a) 200
b) 0.9(10) + 0.1(200) = 29

1.13. a) 400(1) = 400

b) 0.9E(Z) + 0.LE(W) = 0.9(10) + 0.1(400) = 49
1.15. a) 1A+ +0575 = Af:B-
b) 45

1.16. ) g(x,) P(X = 2,) = g(x.)
b) E(e!X) = e!® by a).
) m(t) = zoet®, m7 (t) = x2e!ve, MM (t) = ghetee,

1.17. m(t) = B(eX) =e!P(X = 1) + e 'P(X = —1) = 0.5(e! + 7).

1.18. a) Y ! ze' f(x)
b) > o zf(x) = E(X)
Do e f(2)
2amo ¥ f(x) = B(X?)
e) Xa—pr e f()
1.19. EW") = E(e"X) = mx(r) = exp(ru+1r202/2) where mx(t) is the
mgf of a N(u,0?) random variable.
1.20. a) E(X?) =V (X) + (E(X))? = 0% + p2.
b) B(X3) = 202E(X) + pE(X?) = 20%u + p(o? + p?) = 302 + 1.

a o
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o0 1
1.22. —/ exp(— y Ndy = 1. So/ exp(—§y2)dy = /2r.

e}

1.23. [ f(z]o,0)dz =1, so

/U ﬁdz = 9%9. (11.1)
So . . )
EX" = /U ﬂea(’xelﬂ dx = 909/0 $9—1r+1 dxr = @ _9:)094
by Equation (11.1). So ;
o
EXT= 0—r
for 6 > r.
1.24.

, L +v) 5 vt
EY /Oyr(ér() 1 —y)ldy =

Fo+v) 0+ rv /1 5—|—7’—|—1/ 5+T_1(1
(o +

_ .\l —
TOTW) TG +r+v) Jy TG +rT y)"dy

v)I (5—|—7’)
L0+ r+v)

for r > —¢§ since 1 = fo beta(d + r,v) pdf.

1.25. E(e") = Y2 e% W L expllog(6)y]. But e expllog(d)y] =
eXp[(IOg(Q) +t)y] = expl(log(0) + log(e))y] = eXp[log(9€ )]

So E(e™) = gy [~ log(1 — 0e")] 320 ioriaery ; xpllog(fe’)y] =

1?(%;}1—_9;)) since 1 =Y [logarithmic (fe') pmf] if 0 < fe* <1 or 0 <e' < 1/6

or —oo < t < —log(6).

1.28. a) EX = 0.9EZ+0.1EW = 0.9vA+0.1(10) = 0.9(3)(4)+1 = 11.8.
b) EX? =09V (Z) + (E(Z))?] + 0.1V (W) 4+ (E(W))?]

= 0.9[v\? + (vA)?] + 0.1[10 + (10)?]

= 0.9[3(16) + 9(16)] + 0.1(110) = 0.9(192) + 11 = 183.8.

2.8. a) Fy(w) = PW < w) = P(Y < w—pu) = Fy(w — u). So
fw(w) = o Fy(w = p) = fy(w = p).
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b) Fw(w) = P(W < w) = P(Y < w/o) = Fy(w/o). So fw(w) =
A Fy(wfo) = fr(w/o)L]

c) Fw(w) = PW < w) = P(oY < w—p) = Fy(*3*). So fw(w) =
APV = S5

o

2.9. a) See Example 2.16.
2.11. W = Z% ~ x% where Z ~ N(0,1). So the pdf of W is

14 _w
w2 e 2 1 w
w) = = e 2
Ftw) 2:0(Y)  Vwver

for w > 0.

2.12. (Y —p)/o = |Z| ~ HN(0,1) where Z ~ N(0,1). So (Y — p)* =
02Z?% ~ o?x? ~ G(0.5,207?).

2.16. a) y =e ¥ =t"Hw), and

'dt‘l(w)
dw

' =|—eY|=e".

Now P(Y =0) =0s0 0 <Y <1 implies that W = —log(Y) > 0. Hence

dt™1 1 . 1
fw(w) = fy(t™H(w)) W)l _ “(eTW)xiT e = Zemw/A
dw A
for w > 0 which is the EXP()\) pdf.
2.18. a)
1 oy

ﬂy)Z}\W

where y, ¢, and \ are all positive. Since Y > 0, W = log(1+Y?) > log(1) > 0
t 1

and the support W = (0,00). Now 14 y® = e®, so y = (e¥ — 1)/¢ = t~1(w).
Hence J 1( ) )
t (w 19

— = (% — 1) eV

‘ dw ‘ gb(e )
since w > 0. Thus

dw)| 1 ser -1 1 1

fwlw) = ol ) | = 5 R
e e ) Ea
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1

1(e” —1)' 5 (e — 1!
A (6w)§+1

6’Ll)

1
Xe—w/)\
for w > 0 which is the EXP(\) pdf.

2.25. b)
1

molL+ (%)

where y and u are real numbers and o > 0. Now w = log(y) = ¢t !(w) and
W = e¥ > 0 so the support W = (0, c0). Thus

fly) =

dt='(w)|
dw |y’
and i () N 1 1
fw(w) = fy (7 (w)) dw | 7o 1+ (log(y)—)2]§ N

1
1t (los—py2
moy[l+ (Z55=)?]
for y > 0 which is the LC(u, o) pdf.
2.63. a) EX = BIE[X|Y] = B[, + 6,Y] = fo + 36,

b) V(X) = E[V(X|Y)]+ V[E(X]Y)] = E(Y?) + V(G + 1Y) =
VIY)+ [EY))?+B3V(Y)=10+9 + $210 = 19 + 1082,

2.64. a) X5 ~ N(100, 6).

b)

(é)%((??)» (53))
c) Xp L Xy and X3 1L Xy.
d)

Cov(X1, X3) -1
VVAR(X,)VAR(X;) 3V4

p(X1, Xo) = = —0.2887.
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2.65. a) Y|X ~ N(49,16) since Y 1L X. (Or use E(Y|X) = uy +
Y19Y0s (X — p1z) = 49 4+ 0(1/25)(X — 100) = 49 and VAR(Y|X) = 1 —
Y19X50 Yoy = 16 — 0(1/25)0 = 16.)

b) E(Y|X) = py +X12555 (X — p1z) = 49+10(1/25)(X —100) = 9+0.4X.

¢) VAR(Y|X) = £11 — 215559 591 = 16 — 10(1/25)10 = 16 — 4 = 12.
2.68. a) E(Y) = E[E(Y|A)] = E(A) =
b) V(Y) = E[V(Y|A)] + VIE(Y|A)] = E(A) + V(A) =1+ (1)2 = 2.

y 0 1
2.71.
frly)=PY1=vy) 076 0.24

Som(t) =3, e"f(y) =3, e P(Y =y) = €0.76 + €"0.24
= 0.76 + 0.24¢".
2.72. No, f(z,y) # fx(2)fy(y) = & exp[F(z? + y?)].

2.73. a) E(Y) = E[E(Y|P)] = E(kP) = kE(P) = k5 = kd/10 =
0.4k.

b) V(Y) = E[V(Y|P)] + V(E(Y|P)] = E[kP(1 — P)] + V (kP) =
kE(P) — kE(P?) + k?V(P) =

9 ov
(0+v)>2(0+v+1)

5 v 5\’
k —k + | —
d+v (0+v)2(0+v+1) d+v

= k0.4 — k[0.021818 + 0.16] + £20.021818 = 0.021818%? + 0.21818k.

Y2 0 1 2
fr,(y2) 0.55 0.16 0.29

b) f(n1]2) = F(y1,2)/fv(2) and £(0,2)/ fy, (2) = .24/.29 while
£(1,2)/ fy, (2) = .05/.29
(% 0 1
Frive(ilys = 2)  24/29 =~ 0.8276 5/29 ~ 0.1724

2.77. Note that the pdf for A is the EXP(1) pdf, so A ~ EXP(1).
a) E(Y)=FE[E(Y|N)]=E\) = 1.
b) VY)=EVYN]+VIEYIN]=EMN+V(\)=1+1>=2.
3.1. a) See Section 10.3.
b) See Section 10.13.

2.74. a)
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c¢) See Section 10.42.
d) See Example 3.5.

3.2. a) See Section 10.1.
b) See Section 10.9.
¢) See Section 10.16.
d) See Section 10.35.
e) See Section 10.39.

3.3. b) See Section 10.19.
¢) See Section 10.30.
d) See Section 10.38.
f) See Section 10.43.
g) See Section 10.49.
h) See Section 10.53.

3.4. a) See Section 10.39.
b) See Section 10.39.
c¢) See Section 10.16.

3.5. a) See Section 10.7.
b) See Section 10.12.
c¢) See Section 10.14.
d) See Section 10.29.
h) See Section 10.41.
i) See Section 10.45.
j) See Section 10.51.

3.10. Yes, the top version of the pdf multiplied on the left by I(y > 0)
is in the form h(y)c(v)explw(v)t(y)] where ¢(Y') is given in the problem,
c(v) =1/v and w(v) = —1/(2v*). Hence Q = (—00,0).

4.3. See the proof of Theorem 4.5b.
4.4. See Example 4.14.

4.6. The appropriate section in Chapter 10 gives the 1P-REF param-
eterization. Then the complete minimal sufficient statistic is 7, given by
Theorem 3.6.

4.7. The appropriate section in Chapter 10 gives the 1P-REF param-
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eterization. Then the complete minimal sufficient statistic is 7, given by
Theorem 3.7.

4.8. The approprate section in Chapter 10 gives the 2P-REF parameteri-
zation. Then the complete minimal sufficient statistic is T' = (71(Y), 72(Y))
where T;(Y') = >_" ., t;(Y;) by Corollary 4.6.

i=1

4.10. b) The 2P-REF parameterization is given, so (3.1 V;, > ", e¥7)
is the complete minimal sufficient statistic by Corollary 4.6.
4.26. See Example 4.11.

4.30. Method i): Ex(X —S%) =A—A=0forall A > 0, but P\(X —S% =
0) < 1soT = (X, S?) is not complete.

Method ii): The Poisson distribution is a 1P-REF with complete suffi-
cient statistic Y X;, so X is a minimal sufficient statistic. T = (X, S?) is
not a function of X, so T is not minimal sufficient and hence not complete.

4.31.

flz) = I'(20)

T(0)T(0)

1'(26)
INCHING)

N1 — )t = exp[(0 — 1)(log(z) + log(1 — x))],

for 0 < z < 1, a 1 parameter exponential family. Hence Y " (log(X;) +
log(1 — X;)) is a complete minimal sufficient statistic.

4.32. a) and b)
£() = Tun.y(x) s expl-vlog()]
¢(v)
is a 1 parameter regular exponential family with Q2 = (—oo,—1). Hence
Yo log(X;) is a complete minimal sufficient statistic.

c¢) By the Factorization Theorem, W = (X1, ..., X,,) is sufficient, but W
is not minimal since W is not a function of Y | log(X;).

4.33. f(z1,.y20) = H?=1 flzi) =
2 1" 1 —np? -1 9 M
{\/—27} p exp(T‘z) Iz@qy > pl exp(2f‘2 ZZ:EZ + = Z:EZ)

where @ = (p,0). Hence T(X) = (Xqy, poiy X7, >y X;) is a sufficient
statistic for (u, o).
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4.34. Following the end of Example 4.4, X1y ~ EXP(A/n) with A = 1,
SO E[X(l)] = 1/n.

4.35. Fx,,(z) = [F(2)]" = 2" for 0 < 2 < 1. Thus fx,, (x) = na""" for
0 < z < 1. This pdf is the beta(d = n,v = 1) pdf. Hence

n+l |1

1 1 1 . .
ElXm] = /0 Tfx, (x)de = /0 zna" ' dr = /0 nx"dr = n 0 =T
4.36. Now
fx(@)=I10<x<0+1)
and

f(ar;) B 1(9 < Z@) < T(n) < 0+ 1)
fly) 10 <ya) <yw <0+1)
which is constant for all real 0 iff (z(),2m) = (ya),Yw)). Hence T =

(X@a), X(n)) is a minimal sufficient statistic by the LSM theorem. To show
that T is not complete, first find E(T). Now

t
Fx (1) =/ dr =t —0
)
for 0 <t <60+ 1. Hence
fX(n) (t) - n[FX(t)]n_lfm(t) — n(t o e)n—l
ford <t<6+1and
0+1
Ey(Xw) = /th(n) (t)dt = / tn(t — 0)"dt.
)

Use u-substitution with u =t -6, t = u+ 60 and dt = du. Hence t = 0
implies u = 0, and t = 6 + 1 implies u = 1. Thus

1 1 1
Eo( X)) = / n(u+ 0)u" 'du = / nudu + / nfu" ' du =
0 0 0

1

n nb n

— +— =0+ .
o n+l n n+1

Now



for <t <60+ 1 and thus
+1
Eg(X(l)) = / tn(l — 1+ e)n_ldt.
0

Use u-substitution with u = (1 —¢t+6) and t = 1 —u + 6 and du = —dt.
Hence t = 6 implies v = 1, and ¢t = 6 + 1 implies u = 0. Thus

0 1 1
Eo( X)) = —/1 n(1—u+0)u"'du =n(1+ 9)/0 u" " du — n/o u"du =

ur ! urtt | n n 1
n(l+60)—| — n =0+1)—— =0+ .
n o n+1j, n n+1 n+1
To show that T is not complete try showing Fy(aXq) + bX) +¢) =0
for some constants a,b and c. Note that a = —1,b=1and ¢ = —Z—ﬁ works.
Hence
Ep(—X (1) + Xy — — 1) =0
n+1
for all real 6 but
Pog(T) = 0) = Py(= Xt + Xom — 2 —0) =0 < 1
0(9(T) = 0) = Po(—Xq) + ] =0)=0<

for all real 6. Hence T is not complete.

4.37.

a. Note that X is a complete and sufficient statistic for . X has
N(u,n"to?). We know that E(e*Y), that is the mgf of X when t = 2, is
given by e2¢t207'7* Thug the UMVUE of e2# is e=27 7" ¢2X,

b. The CRLB for the variance of unbiased estimator of g(u) is given by
4n~to?e whereas

V(e 02Xy = i P Bt et (11.2)

— 6—4n*10264u+%16n*102 _ 64“

64“ [64n*102 o 1]

> An~lolett

since e > 1+ x for all x > 0. Hence the CRLB is not attained.

396



4.38. Note that

fly)=1(y>0) 2y e 7 exp[(1—7)(—log(1 —e™¥))]

is a 1 parameter exponential family with minimal and complete sufficient
statistic 31, log(1 — e™7).

5.2. The likelihood function L(f) =

(271r)“ exp(%l[Z( — pcosf)? —I—Z — psin6)?]) =

1
@)

1 —1 .
— @y exp(T[Z z? + Z y? + p*]) exp(pcos 6 le + psinf Zyl)

Hence the log likelihood log L(6)

= c+pcos€2zi+psin92yi.

The derivative with respect to 6 is

—psin@Zzi+pcos92yi.

Setting this derivative to zero gives

pZyicose :prisine

Zyi
pRE

—1
exp(T[Z x7—2pcos 6 Z z;+p* cos® Q—I—Z y?—2psin 6 Z yi+p*sin? 0)])

or
= tan 6.

Thus

N -1 > Yi
0 = tan (ZIZ

Now the boundary points are § = 0 and 6 = 27. Hence OriLe equals 0, 2m,
or 6 depending on which value maximizes the likelihood.

).

5.6. See Section 10.7.
5.7. See Section 10.9.
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5.8. See Section 10.12.
5.9. See Section 10.13.
5.10. See Section 10.16.
5.11. See Section 10.19.
5.12. See Section 10.26.
5.13. See Section 10.26.
5.14. See Section 10.29.
5.15. See Section 10.38.
5.16. See Section 10.45.
5.17. See Section 10.51.
5.18. See Section 10.3.
5.19. See Section 10.14.
5.20. See Section 10.49.
5.23. a) The log likelihood is log L(7) = —Zlog(27m7) — 5= > (Xi — )2

=1

The derivative of the log likelihood is equal to —2-+515 S | (X;—pu)?. Setting
the derivative equal to 0 and solving for 7 gives the MLE 7 = M
Now the likelihood is only defined for 7 > 0. As 7 goes to 0 or oo, log L(7)
tends to —oo. Since there is only one critical point, 7 is the MLE.

b) By the invariance principle, the MLE is W

5.28. This problem is nearly the same as finding the MLE of o? when
the data are iid N(u,0?) when pu is known. See Problem 5.23. The MLE
in a) is > i ;(X; — p)?/n. For b) use the invariance principle and take the
square root of the answer in a).

5.29. See Example 5.5.

5.30.

L(e) — ;6—@—9)2/292

0v2r
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din(L(#)) _ -1 x—46 (x —0)?
do - h 62 63
2 x 1
by solving for 6,
0 = g * (_1 + \/5)7
and .
6= (-1~ V5).

But, 6 > 0. Thus,é=§*(—1+\/§),when:£>0, andézg*(—l—\/g),
when x < 0.
To check with the second derivative

Pin(L©0) 20+ N 3(0% + Ox — 2?)
db? N 63 64
0% + 201 — 3x2

but the sign of the 04 is always positive, thus the sign of the second derivative
depends on the sign of the numerator. Substitute 6 in the numerator and
simplify, you get %(—5 + /5), which is always negative. Hence by the
invariance principle, the MLE of 62 is 62.

5.31. a) For any A > 0, the likelihood function

~(1+7) Zlogm)]

is maximized by making o as large as possible. Hence 6 = Xy).

b)

1
L(o,\) = o™/ Iz > o] T exp

1
L(G,\) = 6" Txqy > 6] 7 P

~(1+75) Zlogm)] .

Hence log L(5,\) =

" og(#) ~ nlog() — (1 + %) ; log ().
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Thus

4 log L(G,\) =

n e
0 5Vl log -3 )\QZlog x;) :t 0,

or —nlog(6) + > 1 log(x;) = nA. So
N >z log(zi) _ 201, log(xi/0)

A = —1log(6) - »

Now

2
L s L(6.0) = i

e 3log& %————Zloga:Z

A=)

)\———Zl og(z;/0) =

Hence (6, ) is the MLE of (o, \).
5.32. a) the likelihood

L(Y) = 50 exp {—(1 Py logm)] |

and the log likelihood

log(L(\)) = d — nlog(A Zlog (x;).

Hence

d —nNn 1 set
— —_ o 1 1 — 5
)\ log(L(\)) DY E og(z;) =0

or Y log(x;) =n\ or

5\ _ Z log(Xz)
n
Notice that

d? n o 2> log(x;)
— log(L(A) = - — -
d\? A2 A3 N

n mA . —n

2w R



Hence A is the MLE of \.
b) By invariance, A® is the MLE of A8,

5.33. a) The likelihood
L(0) = c e7"* expl[log(26) Z xil,
and the log likelihood

log(L(6)) = d — n26 + log(20) > " .

Hence g 5
- _ _2 & ) set
7 log(L(#)) n+ 50 0,
or Y x; = 2n#, or A
0=X)2.
Notice that » >
— S
unless > x; = 0.
b) (0)* = (X/2)* by invariance.
5.34. L(0]z) =1 for 0 < z; < 1, and L(1]z) =[]}, 2\/_

Thus the MLE is 0 if 1 > ]} and the MLE is 1 if 1 <

i=1 2\/_
5.35. a) Notice that § > 0 and

B 1 —(y—90)?
Hence the likelihood

L(#) =c 93/2 exp {g—; Z(yz’ - 9)2]

and the log likelihood

—_

log(L(#)) =d — 2 los(6) ~ 5

PR 2 —
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—ng.
i=1
Thus
d —n1 1 " 1 N set
—log(L(0)) = —= + = 2_ _ "%
or .
“nge_ny 1 2 _
29 29%—2;yZ 0,
or .
nd®> + nf — nyzO.

(11.3)

Now the quadratic formula states that for a # 0, the quadratic equation
ay? + by + ¢ = 0 has roots

—b+ Vb? — 4ac
2a ’

Applying the quadratic formula to (11.2) gives

P +/n2+4nd " y?
— 5 .
Since € > 0, a candidate for the MLE is

Gt V2 +an Yl Y2 _1+\/1+4%Z?:1Y;'2

2n 2
Since 0 satisfies (11.2),
nf — ny = —nb>. (11.4)
i=1
Note that
d? nooX Ly 1 ~
_ _ 1= 3 —_ _ 2 <
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1 . n n 1 . n
250 - Sy =) = Y —;y?] <0

i=1 i=1

by (11.3). Since L(6) is continuous with a unique root on 6 > 0, 0 is the
MLE.

5.36. a) L(0) = (0 —x)*/3forz—2< 60 <x+1.Sincexz =7, L(5) = 4/3,
L(7) =0, and L(8) = 1/3. So L is maximized at an endpoint and the MLE

= 5.
b) By invariance the MLE is h(0) = h(5) = 10 — e~25 ~ 10.
5.37. a) L(\) = ¢35 exp (555 Doiy (€ — 1)%)

222
Thus
_ 1 . T 2
log(L(A)) = d = nlog(A) — 535 ;(e 1)2.
Hence dlog(L() .
0og _ __n i T 1)\2 ng
TS D BICA

or nA? =Y (e” — 1), or

o [2o(eX—1)2
A= n
Now P log(L())) 3
og n z;
dN? A2 M PG N
n 3n ¢ n

So A is the MLE.
5.38. a) The likelihood

1\ 1 —(log x;)?
s =Tl = (IL; ) s =38 .
and the log likelihood

>_(log ZBi)z.

log(L(A)) = d — ) _log(x;) — nlog()) — 2

403



Hence

d _—n > (logxi)? set
or Y (logz;)* = n)\?, or
5 = > (log z;)
n
This solution is unique.
Notice that
d? n 3> (logwx;)?
=L loo(L -
e
n o 3n\2 —2n

Hence

n
is the MLE of \.
b)
32 >_(log X;)
N n

is the MLE of A\? by invariance.

5.39. a) The plot of L(6) should be 1 for z,) — 1 < 6 < (),

otherwise.
b) [C d] [[L’(n 1, [L’(l)].

5.42. See Example 5.6.

and 0

5.43. a) L(0) = L@l e i) g 160(L(6)) = c+nlog(cos(8))+6 3 a;,

112 cosh(wz;/2)

e Alog(L(8) _ 1
do - ncos( —sin(6)] + Z% =0
or tan(f) = 7, or § = tan~(X).
e Plog(L(6)) :
g msec 0) <0

for |0] < 1/2, 0 is the MLE.
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b) The MLE is tan(d) = tan(tan (X)) = X by the invariance principle.

'~

(By properties of the arctan function, § = tan LX) iff
tan(d) = X and —7/2 < 0 < 7/2.)

5.44. a) This is a two parameter exponential distribution. So see Section
10.14 where 0 = X\ and p = 6.

b)
1 — F(x) = 7(u,0) = exp {— (5”;“)] .

By the invariance principle, the MLE of 7(u,0) = 7(f, 5)

Xr — X(l)
= eXp — _ .
X = X

5.45. a) Let

Then the likelihood

and the log likelihood

log(L =c—nl - — -
oB(L(4)) = ¢~ nlog(v) = 573w
Hence
d —n 1 u set
— log(L = — 4+ — i = 0,
i osL) = 4 53
or
5= D Wi
n
This solution is unique and
d? no 3> w n  3nb? —2n
ar B =5 === s T <0
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Thus
Z?:l Wi
n

>
I

is the MLE of v if v > 0.

b) P2 — Z?:l Wi
n

by invariance.

5.46. a) The likelihood

Y

L(\) = c— exp [ Zlog 14y,

and the log likelihood log(L())) = d — nlog(A) — 5 >, log(1 + y;?). Hence

d —n ?: log 1 ‘|‘yZ_ set
3 log(L(Y) = == + Lizt A(? ) st

0,
d\

or S0 log(1+1y; %) =nXor

A = Z?:l log(1 + ?/z_(z))
n

This solution is unique and

d? no 23" log(1+1y;%) n o 20\ —n
—1 L = — — i=1 L = - — —F— — =% <0
Thus

5\ o Z?:l log(l + )/;_(z))
n

is the MLE of A if ¢ is known.
b) The MLE is A\? by invariance.

6.7. a) The joint density

1 1 9
flz) = Wexp[—§ Z(fﬂz — )]

= Gy eol=5 (et = 2 Y )
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1 1 _ n?
— EORE exp[—§ Z 73] exp[nuT — T]

Hence by the factorization theorem X is a sufficient statistic for .

b) X is sufficient by a) and complete since the N(y, 1) family is a regular
one parameter exponential family.

) E(I_(oo(X1)|X =7) = P(X; <t|X =7) = &(—=

d) By Rao-Blackwell-Lehmann-Scheffe,

t—X

é(\/l —1/n

)

is the UMV UE.

6.14. Note that > X; ~ G(n, ). Hence MSE(c) = Vary(T,,(c))+[EeT(c)—
01 = *Vare(d>. X;) + [ncEyX — 0)* = ¢*nb? + [nch — 6]%.

So
%MSE(C) = 2cnb? + 2[nch — O)nd.
Set this equation to 0 to get 2n6%*[c + nc — 1] = 0 or ¢(n + 1) = 1. So
c=1/(n+1).

The second derivative is 2n6? + 2n?6% > 0 so the function is convex and
the local min is in fact global.

6.17. a) Since this is an exponential family, log(f(z|\)) = —log(A) —x /A
and

0 —
—log(f(al\) = 5 + 5
Hence 92 -
S los(FN) = 55 - 55
and 0 12X 1
B =B | g lost )| = 35 + 53 = 5
b)
/ 2 2
FORLB(r(\) = T A

ol (\) /X2
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c) (T' =51, X; ~ Gamma(n, \) is a complete sufficient statistic. Now
E(T?) = V(T)+ [E(T)]? = nA\* + n*\%. Hence the UMVUE of \? is T?%/(n +
n?).) No, W is a nonlinear function of the complete sufficient statistic 7.

6.19.

W = S*(k)/o? ~ x2/k

and
MSE(S*(k)) = MSE(W) = VAR(W) + (E(W) — o2)?

_ 2 gn 22
k22n ( ? o)
2n  n 2n+ (n — k)?
= U4[ﬁ (E —1)% =0 12
Now the derivative LMSE(S?(k))/o* =
-2 —2(n—k
— 2+ (- B+ %

Set this derivative equal to zero. Then
2k* — 2nk = 4n + 2(n — k)* = 4n + 2n* — dnk + 2k*.

Hence
onk = 4n + 2n?

or k=mn-+2.

Should also argue that £ = n + 2 is the global minimizer. Certainly need
k > 0 and the absolute bias will tend to oo as £ — 0 and the bias tends
to 0% as k — 00, so k = n + 2 is the unique critical point and is the global
minimizer.

6.20. a) Let W = X?. Then f(w) = fx(vw) 1/(2y/w) = (1/6) exp(—w/0)
and W ~ exp(f). Hence Ey(X?) = Ey(W) = 6.

b) This is an exponential family and

log( (1)) = los(2r) — log(#) — 5”

for x < 0. Hence 9 . .
“ =2
89f(£v|9) 7t
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and

g (10 = g+ g5
Hence 1 o 1
1(0) = —EG[QQ t 5T ] = 52
by a). Now

where 7(0) = 0.

¢) This is a regular exponential family so Y ;" | X? is a complete sufficient
statistic. Since .
> i X7

n

EO[ ]:97

the UMVUE is ==X

6.21. a) In normal samples, X and S are independent, hence

VargW(a)] = o*Vare(T)) + (1 — a)*Vare(Ty).

b) W («) is an unbiased estimator of §. Hence MSE[W ()] = MSE(a) =
Varg|W («)] which is found in part a).

c) Now
d
%MSE( a) =2aVarg(Ty) — 2(1 — a)Vare(Tz) = 0.
Hence 02
& = Va’r’g(Tg) ~ on ; :1/3
Vm’g(Tl) + VGTG(T2) g—n + %

using the approximation and the fact that Var(X) = #*/n. Note that the
second derivative

2
%MSE( ) = 2[Vare(Th) + Vare(T)] > 0,

so a = 1/3 is a local min. The critical value was unique, hence 1/3 is the
global min.
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6.22. a) X; — Xy ~ N(0,20%). Thus,

o0 1 7u2
E(T)) = U e du
(1) /0 Varo?

b) £ has a N(0,1) and %ﬁXZ has a chi square distribution with n degrees
of freedom. Thus

E( 0,2 - ) - F(Q)Q )
and \/_1“( )
o V2 "—21
P =T
Therefore,

r
gy (+3 T,) -
f 21(%)
6.23. This is a regular one parameter exponential family with complete
sufficient statistic T, = > | X; ~ G(n,\). Hence E(T,) = n\, E(T?) =
V(T,) + (E(T,))? = nA\?> + n?\?, and T?/(n + n?) is the UMVUE of A\2.

6.24.
X, o o’
Hence if
n
= then E( ) —,
no



and T'/n is the UMVUE since f(z) is an exponential family with complete
sufficient statistic 1/X.

6.25. The pdf of T is

2nt2n—1
g(t) = 7o
for0 <t <@.
E(T) = 5250 and E(T?) = 32156°.
2n 2n
MSE(CT) = (C 0 —0)°+C? 2 - 0)>
(CT) = 2n+1 )+ [2n+2 (2n+1)]
dMSE(CT) 2cnd 2n6 2n 6> 4n?6?
= 2| — 0] | + 2¢] — 51
dC 2n+1 2n+1 2n+2 (2n+1)
Solve %C(CT) =0 to get
n+1
=2 .
2n+1
Check with the second derivative dzMjc%(CT) 4;“12, which is always posi-

tive.

6.26. a) E(Y;) = 20/3 and V(Y;) = 6?/18. So bias of T = B(T) =
EcX — 0 =c30 — 6 and Var(T) =

CZ X c? no?
VaT’( = n2 ZV&T’ = EE
So MSE = Var(T) +[B(T)]2 =
202 20 9
18 T
b)
dMSE(c)  2c6? 20 20
- 2(Zc —0)=.
dc TR S
Set this equation equal to 0 and solve, so
0%22c 4 2
18 39(390—9)—0
o 202 8 4
U7 %
s T =37
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or

1 8 4
. _92:_92
g, t5%) =3
or
(1+8n)_4
Oon Ton’ T 3
or
In 4_ 12n

“T1isn3 1+sn
This is a global min since the MSE is a quadratic in ¢? with a positive
coefficient, or because

>MSE(c) 267 N 862 .
de? 18 9 ‘

6.27. See Example 6.5.

6.30. See Example 6.3.

6.31. a) E(T) =cE(Y) = caff = 10cf.
V(T)=cV(Y) = 2ap?/n = 10c?3? /n.
MSE(T)=V(T)+ [B(T)]* = 10c*3?/n + (10c¢ — 3)>.

d MSE(c)  2c105?
dc B

or 208%/n ¢+ 2008% ¢—2082 =0

orc/m+10c—1=0orc(l/n + 10) =1

or

b) +2(10¢8 — £)108 £ 0

B 1 B n
S 1410 10m+1

Cc

This value of ¢ is unique, and

+2005% > 0,

& MSE(c) 203
dc? on

so ¢ is the minimizer.

6.32. a) Since this distribution is a one parameter regular exponential
family, T, = — Y. log(2Y; — Y;?) is complete.

7

b) Note that log(f(y|v)) = log(v) + log(2 — 2y) + (1 — v)[— log(2y — y?)].

Hence
d log(f(y|v))

1
=~ 1 log(2y — 12
o V+og(y y~)
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and
d* log(f(ylv)) _ -1

dv? Ze
. . o -1 1
Since this family is a 1PREF, I (v) = —F (—2) =—.

v v

gl _ v 1
nhL(v) vin 2
1 I'(—1
d) E[T7Y = (E1n) Y S 1)/T, is the UMVUE of »

vt T'(n) n—1
by LSU.
6
6.33. a) Since f(y) = i[exp[—(e +1)log(1 + |y|)] is a IPREF,
T =757 log(1+Y;]) is a complete sufficient statistic.
b) Since this is an exponential family, log(f(y|f)) = log(6/2) — (0 +
1)log(1 + |y|) and

0 1
%log(f(yIQ)) =g~ log(1 + |yl)-
Hence o )
o5 108(fWl0) = o
and
0? 1
1(0) = o | 5 01V I0)] = 7z

c¢) The complete sufficient statistic ' ~ G(n,1/6). Hence the UMV UE of
0 is (n — 1)/T since for r > —n,

E(T") = E(T") = (%) F(;(Z)”).
> Ly P 1)
B(T™) = 0= = 0/(n = 1)

7.6. For both a) and b), the test is reject Ho iff [}, (1 —x;) > ¢ where
Py [Ty ws(1 — ) > ] = o

7.10. H says f(z) = e~® while K says
flx) =2’ e /T(8).
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The monotone likelihood ratio property holds for [] z; since then

ful,62) _ ([T 20)™  (000)" _ D0 0 7 0y
Tl ) ~ ([0, P (T — i) L)

which increases as H?:l x; increases if 65 > 6. Hence the level o UMP test
rejects H if

i=1

where

7.11. See Example 7.7.

7.13. Let #; = 4. By Neyman Pearson lemma, reject Ho if

Tom = (77) () ==

iff |
ifft

(7
ifft

in log(61/2) > .
So reject Ho iff Y~ X; > ¢ where P2 (> X; > ¢) = a.
7.14. a) By NP lemma reject Ho if

f(x]o = 2)
f(x]o = 1)

> k.

The LHS = ) . )
5w expl5 D 7]
exp[Z 3 7]
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So reject Ho if
1 o101 ,
ﬁeXP[Z%(§ - g)] >k
or if Y22 > k where Py,(>_ 22 > k) = a.
b) In the above argument, with any o > 1, get

1 1
2 —_— —_——
Zzi(g 20%)

1 1
2 207

and
>0

for any o? > 1. Hence the UMP test is the same as in a).

7.15. a) By NP lemma reject Ho if

The LHS = — )
o xp[5 > [log(i)]"]

So reject Ho if . L
xS llog(@ )} — L] > K
or if Y [log(X;)]?> > k where Py,(>[log(X;)]? > k) = a.

b) In the above argument, with any o > 1, get

1 1
and
2 207

for any o7 > 1. Hence the UMP test is the same as in a).

7.16. The most powerful test will have the following form.

; s fi(z)
Reject Hy iff @ > k.
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But ;;Eg = 42~3 and hence we reject Hy iff X is small, i.e. reject Hy is
X < k for some constant k. This test must also have the size «a, that is we
require:

a = P(X < k) when f(z) = fo(z)) = Ok Satde = 5k,

so that k = 4as.

For the power, when k = 4as

PIX < k when f(z) = fi(2)] = [ &/ade = /a.

When o = 0.01, the power is = 0.10.

7.19. See Example 7.5.

7.20. E[T(X)] = 1/A; and the power = P(test rejects Hy) = Py, (T'(X) <
log(100/95)) = F),(log(100/95))
=1 — exp(—X; 1og(100/95)) = 1 — (95/100)*:.

a) Power = 1 — exp(—1og(100/95)) = 1 — exp(log(95/100)) = 0.05.

b) Power = 1 — (95/100)% = 0.923055.

c) Let Tj be the observed value of T'(X). Then pvalue = P(W < Tp)
where W ~ exponential(1) since under Hy, T(X) ~ exponential(1l). So
pvalue = 1 — exp(—1p).

7.21. Note that
f(z)=1I(x >0) 2z e 7 exp[(T — 1)(log(1 — e_mz))]

is a one parameter exponential family and w(7) = 7 — 1 is an increasing
function of 7. Thus the UMP test rejects Hy if T'(z) = 3.1, log(1—e %) > k
where a = P,o(T(X) > k).

Or use NP lemma.

a) Reject Ho if

x|T =14
farr =1 >
The LHS = S s .
;l_n Hﬁ%(l(;_e e:vﬂ)%) =2 [J0 ey
i=1 i1
So reject Ho if i
H(l —e ") >k
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or

=1
or .
Zlog(l — e_m?) >d
i=1
where

n

a=Po(J[(1—e7) > 0).

i=1
b) Replace 4 — 1 by 71 — 1 where 7, > 2. Then reject H if

n

H(l N 6—95?)7-1—2 <> K

i=1
which gives the same test as in a).

7.22. By exponential family theory, the UMP test rejects Hy if
T(x)=—- " L >k where P—(T(X) > k) = a.

Alternatively,luse the Neyman Pearson lemma:

a) reject Ho if

The LHS =

So reject Ho if

or if—zm% > k where Pl(—zm% > k) = a.
b) In the above argument, reject Hy if

2" exp[(—61 + 1) Z l] >k

X

orif —> mi > k where Py (=) mi > k) = « for any 6; > 1. Hence the UMP
test is the same as in a).
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7.23 a) We reject H iff ;;Eg > k. Thus we reject Hy iff ﬁ > k. That
is =% < ky, that is L < ko, that is # > k3. Now 0.1 = P(X > k3) when
f(z) = fo(z), so ks =1 —+/0.1.

7.24. a) Let k = [2m0105(1 — p?)*/?]. Then the likelihood L(8) =

oo (B [(5) - (5) (52) (45 ])

Hence
L() = ! ex ;i(T—QAT + Ty)
" Rreiaa— ) P\ gy MR
! (=n)
pr— X —
2r6155(1 — ) P
and
L(@)—# ii(T + Ts)
0/ = [277'6’16’2]” eXp 2 im1 ! 3
1
— 7[2%&152]” exp(—n).
Thus Az, y) =
L(0 .
( /\0) — (1 _p2) /2.
L()

So reject Hy if A(z,y) < ¢ where a = supg_o P(A(X,Y) < ¢). Here O, is
the set of @ = (uy, ji2, 01, 09, p) such that the p; are real, o; > 0 and p = 0,
ie, such that X; and Y; are independent.

b) Since the unrestricted MLE has one more free parameter than the
restricted MLE, —21log(A(X,Y)) ~ x?, and the approximate LRT rejects
H if —2log ANz, y) > x7.,_, where P(x] > x7,_,) = .

8.1 ¢) The histograms should become more like a normal distribution as
n increases from 1 to 200. In particular, when n = 1 the histogram should be
right skewed while for n = 200 the histogram should be nearly symmetric.
Also the scale on the horizontal axis should decrease as n increases.

d) Now Y ~ N(0,1/n). Hence the histograms should all be roughly
symmetric, but the scale on the horizontal axis should be from about —3/+/n

to 3/y/n.

418



8.3. a) E(X) = thus

9+1>
V(X — E(z)) D N(0,V(z)), but
V(z) = %. Let g(y) = 3%, thus ¢'(y) = ﬁ Using the delta
D 0(6+1)
method, \/H(Tn - ) ( ) (912 )
b) It is asymptotically efficient if \/n(T,, — 0) i N(0,v(0)), where
d
7
v(0) = (%)
—E(ginf(x]0))
But, E((; ln f(:c|9)) . Thus v(§) = 62 # 2051°
c) X — 9+—1 in probablhty Thus T, — 6 in probability.

8.5. See Example 8.8.
8.7. a) See Example 8.7.

8.13. a) Y, 2 S . X; where the X; are iid x?. Hence F(X;) = 1 and
Var(X;) = 2. Thus by the CLT,

vn (%—1)2\/5 (%-1)2}\](0,2).

b) Let g(6) = 3. Then ¢'(0) = 30%, ¢’(1) = 3, and by the delta method,

NG (ﬁ) -1 ] ZON(0,2(¢/(1))%) = N(0, 18).

n

8.23. See the proof of Theorem 6.3.

8.27. a) See Example 8.1b.
b) See Example 8.3.

c¢) See Example 8.14.

8.28. a) By the CLT, v/n(X — A\)/VA 2 N(0,1). Hence v/n(X — \) 2
N(0, A).

b) Let g(A) = A3 so that ¢'(A) = 3A2 then v/n](X)3—(A)?] 2 N(0, A[¢/(V)]?) =
N(0,9)%).

8.29. a) X is a complete sufficient statistic. Also, we have has a
chi square distribution with df = n—1, thus since o2 is known the distribution

(n—1)S?
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of S? does not depend on p, so S? is ancillary. Thus, by Basu’s Theorem X
and S? are independent.

b) by CLT (n is large ) \/n(X — ) has approximately normal distribution
with mean 0 and variance o2. Let g(z) = 2, thus, ¢ (z) = 322. Using
delta method /n(g(X) — g(u)) goes in distribution to N(0,02(g (1))?) or
V(X — 1) goes in distribution to N(0,02(342)2). Thus the distribution

3 . . . . 2,4
of X" is approximately normal with mean p® and variance 909“ .

8.30. a) According to the standard theorem, /n(f, — 6) — N(0,3).

b) E(YY) =0,Var(Y) = %, according to CLT we have /n(Y, — 0) —
N(0,T).

¢) MED(Y) = 0, then \/n(MED(n) — 0) — N(0, yparepry)
f(MED(Y)) = 722l 00y — 1. Thus /n(MED(n) —6) — N(0, ) —
Vn(MED(n) —60) — N(0,4).

d) All three estimators are consistent, but 3 < T < 4, therefore the

3
estimator 6, is the best, and the estimator MED(n) is the worst.

and

8.32. a) F,(y) = 0.5+ 0.5y/n for —n <y <n, so F(y) = 0.5.
b) No, since F'(y) is not a cdf.

8.33. a) F,(y) =y/nfor 0 <y <mn,so F(y) =0.
b) No, since F'(y) is not a cdf.

8.34. a)
_ 11— 1—
() e (e )
p p
by the CLT. _
¢) The method of moments estimator of p is p = HL?

d) Let g(0) = 1+ 6 so ¢'(#) = 1. Then by the delta method,

_ 1— b 1—
vi (o= o205 ) 2 (02200
p p
Jn ((1+Y)— —) BN(O,—Q”).
p p
This result could also be found with algebra since 1 +7—% =Y +1-— % =

Y4+l y 1l
Y + > =Y PR

or
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e) Y is the method of moments estimator of E(Y) = (1 —p)/p,s0 1+Y
is the method of moments estimator of 1 + E(Y) = 1/p.

8.35. a) v/n(X — p) is approximately N(0,0?) Define g(z) = I, ¢/'(z) =
=+. Using delta method v/n(5 — %) has approximately N (0, Z—j) Thus + has
approximately N(%, 7;‘—;), provided p # 0.

bl) Using part a)

1
< is asymptotically efficient for — if

1

o’ _ (7'(1)”

pt ) 2
(5 m /)
1

T(u) = p

) = =
1

2 202
d > B(X - p)?
B ynmrxm| =25
1
T o2
Thus )
(7'(1)) o’

8.36. a) E(Y*) = 20F/(k + 2) so E(Y) = 20/3, E(Y?) = 6*/2 and

2
9 — 20 D 0
V(Y)=2/18.50 Vit (V=5 ) &N (0,5 ) by the CLT.
b) Let g(7) = log(7) so [¢'(7)]* = 1/7% where 7 = 20/3. Then by the
delta method,

vn ( log(Y) — log (?) ) 2N (0, %)

c) OF = B2 Yk,
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9.1. a) Y. | X? is minimal sufficient for a.

b) It can be shown that XTb has an exponential distribution with mean 1.

Thus, %szb is distributed y3,. Let X%n,a/2 be the upper 100(3a)% point

of the chi-square distribution with 2n degrees of freedom. Thus, we can write

2% i X7
a

l-—a= P(X%n,l—a/2 < < X%n,a/2)

which translates into

Y

<zzz;1 Xt o2y, Xf’)

2 2
Xona/2  Xoni-a/2

as a two sided (1 — «) confidence interval for a. For a = 0.05 and n = 20, we
have X%n,a/2 = 34.1696 and X%n,l—a/2 = 9.59083. Thus the confidence interval

for a is
(Z?zl X} Y X} )

17.0848 7 4.795415
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9.4. Tables are from simulated data but should be similar to the table
below.

n p ccov acov

50 .01 .4236 .9914 ACT CI better

100 .01 .6704 .9406 ACT CI better

150 .01 .8278 .9720 ACT CI better

200 .01 .9294 .9098 the CIs are about the same
250 .01 .8160 .8160 the CIs are about the same
300 .01 .9158 .9228 the CIs are about the same
350 .01 .9702 .8312 classical is better

400 .01 .9486 .6692 classical is better

450 .01 .9250 .4080 classical is better

9.11. The simulated coverages should be close to the values below. The
pooled t CI has coverage that is too small.

pCOV  mMpCOV WCOV
0.847 0.942 0.945

9.12. a) Let W; ~ U(0,1) for i = 1,...,n and let T, = Y/6. Then

P(E <t) = P(max(Wy,...,W,,) <t) =

P(all W; <t) = [Fw,(t)]" =t" for 0 <t < 1. So the pdf of T, is

d
fr, (t) = pridie nt"!
for 0 <t < 1.
b) Yes, the distribution of T,, = Y/# does not depend on 6 by a).
c¢) See Example 9.21.
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11.3 Tables

Tabled values are F(0.95,k,d) where P(F < F(0.95,k,d)) = 0.95.

00 stands for co. Entries produced with the qf (.95,k,d) command in R.
The numerator degrees of freedom are k£ while the denominator degrees of
freedom are d.

k 1 2 3 4 5 6 7 8 9 00
d

1 161 200 216 2256 230 234 237 239 241 254
2 18.5 19.0 19.2 19.3 19.3 19.3 19.4 19.4 19.4 19.5
3 10.1 9.56 9.28 9.12 9.01 8.94 8.89 8.85 8.81 8.53
4 7.71 6.94 6.59 6.39 6.26 6.16 6.09 6.04 6.00 b5.63
5 6.61 5.79 5.41 5.19 5.05 4.95 4.88 4.82 4.77 4.37
6 ©5.99 5.14 4.76 4.53 4.39 4.28 4.21 4.15 4.10 3.67
7 5.59 4.74 4.35 4.12 3.97 3.87 3.79 3.73 3.68 3.23
8 5.32 4.46 4.07 3.84 3.69 3.58 3.50 3.44 3.39 2.93
9 5.12 4.26 3.86 3.63 3.48 3.37 3.29 3.23 3.18 2.71
10 4.96 4.10 3.71 3.48 3.33 3.22 3.14 3.07 3.02 2.54
11 4.84 3.98 3.59 3.36 3.20 3.09 3.01 2.95 2.90 2.41
12 4.75 3.89 3.49 3.26 3.11 3.00 2.91 2.8 2.80 2.30
13 4.67 3.81 3.41 3.18 3.03 2.92 2.83 2.77 2.71 2.21
14 4.60 3.74 3.34 3.11 2.96 2.85 2.76 2.70 2.65 2.13
15 4.54 3.68 3.29 3.06 2.90 2.79 2.71 2.64 2.59 2.07
16 4.49 3.63 3.24 3.01 2.85 2.74 2.66 2.59 2.54 2.01
17 4.45 3.59 3.20 2.96 2.81 2.70 2.61 2.55 2.49 1.96
18 4.41 3.55 3.16 2.93 2.77 2.66 2.58 2.51 2.46 1.92
19 4.38 3.52 3.13 2.90 2.74 2.63 2.54 2.48 2.42 1.88
20 4.35 3.49 3.10 2.87 2.71 2.60 2.51 2.45 2.39 1.84
256 4.24 3.39 2.99 2.76 2.60 2.49 2.40 2.34 2.28 1.71
30 4.17 3.32 2.92 2.69 2.53 2.42 2.33 2.27 2.21 1.62
00 3.84 3.00 2.61 2.37 2.21 2.10 2.01 1.94 1.88 1.00
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Tabled values are t, 4 where P(t < t,q4) = a where t has a t distribution
with d degrees of freedom. If d > 29 use the N(0,1) cutoffs d = Z = oc.

alpha pvalue
d 0.005 0.025 0.05 0.50.95 0.975 0.995 left tail
1 -63.657 -12.706 -6.314 0 6.314 12.706 63.657
2 -9.926 -4.303 -2.920 0 2.920 4.303 9.925
3 -5.841 -3.182 -2.353 0 2.353 3.182 5.841
4 -4.604 -2.776 -2.132 0 2.132 2.776 4.604
5 -4.032 -2.571 -2.015 0 2.015 2.571 4.032
6 -3.707 -2.447 -1.943 0 1.943 2.447 3.707
7 -3.499 -2.365 -1.895 0 1.895 2.365 3.499
8 -3.356 -2.306 -1.860 O 1.860 2.306 3.355
9 -3.2560 -2.262 -1.833 0 1.833 2.262 3.250
10 -3.169 -2.228 -1.812 0 1.812 2.228 3.169
11 -3.106 -2.201 -1.796 0 1.796 2.201 3.106
12 -3.055 =-2.179 -1.782 0 1.782 2.179 3.055
13 -3.012 -2.160 -1.771 0 1.771 2.160 3.012
14 -2.977 -2.145 -1.761 0 1.761 2.145 2.977
15 -2.947 -2.131 -1.763 0 1.753 2.131 2.947
16 -2.921 -2.120 -1.746 0 1.746 2.120 2.921
17 -2.898 -2.110 -1.740 0 1.740 2.110 2.898
18 -2.878 -2.101 -1.734 0 1.734 2.101 2.878
19 -2.861 -2.093 -1.729 0 1.729 2.093 2.861
20 -2.845 -2.086 -1.7256 0 1.7256 2.086 2.845
21 -2.831 -2.080 -1.721 O 1.721 2.080 2.831
22 -2.819 -2.074 -1.717 O 1.717 2.074 2.819
23 -2.807 -2.069 -1.714 0 1.714 2.069 2.807
24 -2.797 -2.064 -1.711 O 1.711 2.064 2.797
25 -2.787 -2.060 -1.708 0 1.708 2.060 2.787
26 -2.779 -2.066 -1.706 0 1.706 2.056 2.779
27 -2.771 -2.062 -1.703 O 1.703 2.052 2.771
28 -2.763 -2.048 -1.701 O 1.701 2.048 2.763
29 -2.756 -2.045 -1.699 0 1.699 2.045 2.756
Z -2.576 -1.960 -1.645 0 1.645 1.960 2.576
CI 90% 95% 997

0.995 0.975 0.95 0.5 0.05 0.025 0.005 right tail
0.01 0.06 0.10 1 0.10 0.05 0.01 two tail
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